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What is Financial modeling?
� Wikipedia - Financial modeling is the task of building an abstract 

representation (a model) of a real world financial situation. This is a 
mathematical model designed to represent (a simplified version of) the 
performance of a financial asset or portfolio of a business, project, or any 
other investment.

� Investopedia - The process by which a firm constructs a financial 
representation of some, or all, aspects of the firm or given security. The 
model is usually characterized by performing calculations, and makes 
recommendations based on that information. The model may also 
summarize particular events for the end user and provide direction 
regarding possible actions or alternatives.
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What’s the goal of financial 
modeling?
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A Brief History of Data Analysis
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Why Excel?
� Spreadsheets have evolved from electronic ledgers to 

full-featured analysis software.

� Comprehensive image and drawing tools.

� Word processing capability (not nearly as uncommon as 
you might think!).

� Advanced file save and sharing.

� Game development (?)
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If we’re building something…

If we’re building a representation, we’re gonna
need tools. We’ll use these tools to build a 
representation that enables us to make a good 
decision:

� Formulas
� Graphs
� Statistics
� Pivot Tables

Formulas

Graphs

Statistics
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Formulas
The lifeblood of Excel



Formulas

How many formulas are there? No one seems to know. 
There’re a bunch of them.  And at least 350 functions:

� Logical (IF, AND, OR)
� Text (CLEAN, LEN, TRIM)
� Date & Time
� Lookup and Reference 
� Math & Trig
� Statistical, Financial, Engineering, 
� And, of course, Financial
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What’s the difference between 
a formula and a function?

Formulas are 
expressions that 

calculate the value 
of a cell

Functions are
pre-defined 

formulas
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What’s the difference between 
a formula and a function?
In the previous example, 
both expressions start with 
an ‘=‘ sign. The time 
required to enter the 
expressions is about the 
same.  And the results are 
identical.

But what if we have a larger 
data set, say 5 data points?
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Math made easy(er)
We’ll talk about 

statistics more later. But, 
for now, let’s look at 

how much easier it is to 
do complex calculations 

in Excel.
At top right, Function 

Arguments can be used 
to calculate a standard 

deviation.
The math calculation 

looks like this:
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Enter a formula
Typically, there are multiples ways to do something on a 
computer. Formulas are no different:

� Type in manually
� Use the Formula tab
� Use the dialog box
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Working smarter with formulas

Household budgets are simple financial models. Let’s start 
with a monthly household income of $5,000.  After much 
discussion, your client has decided to allocate the 
following:
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Using and copying formulas

Now we need to calculate a dollar amount for each 
category.  We could do this for each cell:

Then, press ENTER:

Notice that Excel is 
smart enough to 
convert the percent 
sign
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A smarter kind of formula
We could also use cell references to do the calculations:
Notice that we use an absolute reference when referring to 
household income. This is because we’ll use that value to 
calculate the dollar amount for each category.
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Copying formulas
Now that we have a working formula, complete with the 
correct cell references, copy the formula into each cell.
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You’d think….
… that with all of the functions, formulas, and features in 
Excel, there would be a way to calculate Return on 
Investment (ROI). But, sometimes there’s no substitute for 
home cooking:
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Creating What-If scenarios
The ability to copy 
formulas lets us 
quickly create 
what-if scenarios. 
Copy the formula 
to a new cell and 
edit the 
parameters 
directly :
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Graphs and Charts
Every picture tells a story



Every picture tells a story
Graphs and charts are 
pictorial illustrations                                                                 
of inter-relationships 
between two or more                                                  
things:

� Column
� Line
� Pie
� Area 
� Bar
� Histogram
� Waterfall
� Bar and Whisker
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Inserting a chart or graph
To insert a chart or graph into an Excel sheet, click the 
kind of chart that you want on the Insert tab:
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Pie charts
Pie charts are useful for comparing parts to a whole, 
so we’ll use a pie chart to illustrate a household 
budget.
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Adding some polish
Our chart is 
useful, but needs 
some help to be 
really useful. Let’s 
add some polish. 
To do this, click 
the ‘+’ and then 
click to select the 
options that you 
want.

FatDAWGS.com



Line charts
A pie chart works 
for our household 
budget, but what 
about showing the 
movement of a 
stock price over 
time? 
Well, a pie chart 
wouldn’t work very 
well. For that, we’ll 
use a line chart.
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Bar charts
What if we want to 

compare two stocks 
over time? We could 

use a line chart 
again:

But we could also 
use a bar chart:
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Statistics
The stars might lie but the 
numbers never do



“There are lies, damn lies, and 
statistics”
Variations on the above are attributed to both Mark Twain 
and Benjamin Disraeli.
But we love statistics.  Politicians love them. Sports fans 
REALLY love statistics. The past few years have seen an 
explosion of sports statistics: Gross Production Averages, 
Defensive Runs Saved, and Defense Independent Component 
statistics in baseball. Top speed and acceleration numbers in 
football.

We’ll talk about the following statistical measurements:

◦ Mean – The average. Add up the data points and divide by the 
count.
◦ Forecast – Lets us predict a future value based on existing 

values
◦ Standard deviation – Helps us understand the distribution
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What does mean mean?
The mean of a data 
set is the average. 
Sum the values in a 

data set, and then 
divide by the count.
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Mean, median, mode
Median and mode are two statistical measures often 
used with mean (average). What are the median and 
mode?
◦ Median – Half the values in the data set are above the 

median and half are below. Median can be used with the 
mean to estimate volatility. 
◦ Mode – The value that occurs most often.
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Descriptive Statistics – One stop stats

The previous analysis yields some useful information, but 
there’s a lot of mucking about writing formulas and 
formatting cells. Wouldn’t be cool if there was a way to 
make these calculations with a couple of mouse clicks?
Happily, there is a way. For that, we’ll use Descriptive 
Statistics in the Analysis group on the Data tab.
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Hmm…
That’s odd,  I don’t see the Analysis group anywhere. 
That’s because we need to load the Analysis ToolPak.

1. Click the File tab, and then click Options.
2. Click Add-Ins, and then in the Manage box, select 

Excel Add-ins.
3. Click Go.
4. In the Add-Ins available box, select the Analysis 

ToolPak check box, and then click OK.
a) If the Analysis ToolPak is not listed in the Add-Ins 

available box, click Browse to locate it.
b) If you get prompted that the Analysis ToolPak is not 

currently installed on your computer, click Yes to install it.
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There it is…
5. After you load the Analysis ToolPak, the Data Analysis

command is available in the Analysis group on the 
Data tab.
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Using Descriptive Statistics
To use Descriptive Statistics, click Data Analysis, select, 
Descriptive Statistics, and then click OK:
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Setting Descriptive Statistics 
options
In the dialog box, set the input and output ranges, select 
Summary statistics, and then click OK:
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Getting the values
After you click OK, several values, including mean, 
median, and mode, appear in the output range:

Along with something called Standard Deviation. What 
the heck is Standard Deviation?
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Standard Deviation
Earlier, we talked about using the mean and mode values to 
estimate volatility. Lower volatility means that the values 
do not fluctuate as dramatically, but increase or drop at a 
steadier rate.

Investopedia says:
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Understanding Standard Deviation

To understand standard deviation, we need to look at 
something that we all probably hated in high school. The 
bell curve, or normal distribution.

The values along the horizontal axis are standard 
deviations. This means that, in a normal distribution, we 
can expect 68.2% of the data points to lie within one 
standard deviation (plus or minus) from the mean.
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Using standard deviation 
Statistics are useful for comparison. Let’s compare two 
stocks using Descriptive Statistics:

From these values, we might conclude that Stock B 
would offer a better return, but is also a riskier 
investment.
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Forecasting
So far, we’ve used Excel to analyze current and historical 
data. It would certainly be cool if we could predict future 
data points.

We can do that. There are actually several predictive 
functions in Excel, but we’ll use the FORECAST,LINEAR 
formula to see into the financial future.
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Using FORECAST,LINEAR
To use FORECAST,LINEAR, select More Functions on 
the Formulas tab, select Statistical, and then select 
FORECAST,LINEAR:
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Enter the values for FORECAST,LINEAR

Enter the values in the dialog box. In this example, we 
have 10 historical data points, and we’ll calculate the 
predicted value at the 15th data point. For example, if 
the existing data points are monthly values, we’ll 
calculate the value five months from now:

FatDAWGS.com



Comparing two stocks
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Adding a little Confidence…
Or perhaps a little uncertainty. By using the 
CONFIDENCE function, we can say “I’m 95% confident 
that the number is within this interval”.
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Dang, them Texans was right
The previous confidence intervals were generated using a 
small data set. What happens if we have a larger data set, 
say 30 or 100 data points?
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Multiple Criteria Decision Making 
(MCDM)
MCDM is pretty much what it sounds like. You define a 
number of criteria to evaluate.

For example, if we want to evaluate the possibility that a 
stock price will go up, we might define the three following 
criteria and then assign a “1” (Yes) or “0” (No) to each 
criteria:
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We’re getting there…
Now our work is beginning to resemble a financial analysis 
(minus any narratives to support our analysis):
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Pivot Tables and Charts
Data mining on the cheap



What’s with the “pivot” thing anyway?

There are a lot of ways to summarize, analyze, and display data 
in Microsoft Excel 2010.  You can order data, filter data, sort 
data, analyze data by using statistical and financial functions, 
create pie charts, line charts, scatterplots… on and on.
We can also use pivot tables and pivot charts. Not only are 
pivot tables and pivot charts really hip buzzwords, it turns out 
the pivot tables and pivot charts are really cool ways to 
aggregate and analyze data in new ways. In some respects, you 
can think of pivot tables and pivot charts as down-level versions 
of data mining (now there’s a buzzword for your next party).
But, why are they called pivot tables and charts? Well, because 
you can pivot columns and rows in a workbook. In other words 
you can make columns into rows and vice versa.
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Creating a pivot table
First, we’ll need 

some data:
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Insert a pivot table
To create a pivot table, 

click the Insert tab, 
click PivotTable, and 

then click PivotTable:
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Select the data
In the Create Pivot 

Table dialog box, click 
the Table/Range icon 

to select the data that 
you want to analyze. 
You can either type 

the cell references for 
the range of data that 
you want to analyze, 
or you can click and 
drag to highlight the 

range.

FatDAWGS.com



We gotta put it somewhere…
In the Create PivotTable dialog box, click Existing 
Worksheet, click the cell where you want to insert the 
pivot table, and then click OK:
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Hey, where’s my data?
After you click 
OK, the pivot 

table, the 
PivotTable Field 
List dialog box 

appears. Notice 
that there is no 

data in the pivot 
table yet. To 

populate the pivot 
table, we need to 

select the data 
fields that we 

want
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Manipulating data
We can make the product gross 
sales comparison even easier if 
we collapse the detail view for 
each product:
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Changing the view
One way to manipulate the sales data is to display the 
data by region. To do this, we need to move the  
“Products” or “Sales Regions” data to a column. 
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Demonstrations in Excel
� Household budget to introduce formulas and pie charts
� Calculations using financial formulas in Excel
◦ PMT function

◦ CUMIPMT function

◦ FV function

� Creating column charts
� Statistics
◦ AVERAGE

◦ STDEVS

◦ FORECAST,LINEAR

� Pivot Tables
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Lessons (I’ve) Learned
� Know the problem that you’re trying to solve
� Know the scope, benefits and limitations of the financial 

model
� Garbage in garbage out – Be confident in your data set
� Your model should be:
◦ Simple
◦ Easy to understand
◦ Flexible enough to accommodate future revisions.

� Remember the goal: Be able to take a decision based on 
your financial model
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